
This is a guideline to daylight simulations with MircoShade® in LightStanza. LightStanza is an advanced web-based simulation 
software for simulating daylight in buildings. LightStanza is developed by Light Foundry, LLC.

This guideline shows how to use MicroShade® in LightStanza for simulation of daylight in a building. For further questions 
regarding LightStanza simulations, please contact LightStanza support at support@lightstanza.com. For questions 
regarding MicroShade®, please contact us at support@microshade.com.

Simulation of MicroShade® in LightStanza

About MicroShade®

MicroShade® is a highly effective shading product containing microscopic shading lamellas. The shading efficiency depends on 
the incidence angle of the sun on the lamellas. When the sun is high in the sky during the summer, MicroShade® provides the 
strongest shading and during winter when the sun is low more heat is allowed into the building. Similarly, the shading efficiency 
also varies during the day due to the different positions of the sun during morning, noon and evening.

Daylight metrics
It is recommended to use either spatial Daylight Autonomy (sDA) or Useful Daylight Illuminance (UDI) as the evaluation metric 
when simulating daylight conditions in a room or building. LightStanza can calculate both daylight metrics under the “Annual 
Grid Illuminance”.

sDA describes the percentage of floor area that receives daylight above a threshold, usually 300 or 500 lux, for at least 50% 
of the annual occupied hours (LEED) or annual daylight hours (EN 17037). 

UDI describes how many hours, workhours or percentage of the year where the daylight levels are within the desired 
interval (usually 100-3000 lux). Lower illuminance levels require artificial light and higher illuminance levels cause a risk of 
overheating and glare.

However, other metrics are also available such as ASE and cDA. It is also possible to calculate the average illuminance.

About LightStanza
LightStanza is a browser- and cloud-based daylight simulation tool. It is the fastest Radiance-based tool on the market and 
can perform several types of daylight simulations, both annual and specific point in time calculations. The calculations can 
be performed with standard CIE sky conditions, with annual weather data chosen from the location or your own weather 
data in epw format for proof of regulations.

The great advantage of using LightStanza is the fast simulation time and that multiple simulations can be performed 
simultaneously in the cloud, without having to install the tool on your computer. MicroShade® is implemented in the 
LightStanza software and can be selected under the material library.
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Usage
BSDF (Bi-Directional-Scattering-Distribution-Function) files of MicroShade® have been developed and are made directly 
available in LightStanza through their material library. 

For façade applications  MicroShade® is commonly combined with either a low energy coating or an extra low energy 
coating. An extra low energy coating provides a stronger shading, whilst a low energy coating allows more daylight inside. 
For roof applications MicroShade® can also be combined with a solar control hard coating to provide additional shading. 
For more information on selection of MicroShade® please see our selection guidelines www.microshade.com

The most common applications of MicroShade®, directly available  in the LightStanza material library,  are: 

Facade application
• Facade 2-Layer Low-E 1

• Facade 2-Layer Extra-Low-E 2

• Facade 3-Layer Low-E 3

• Facade 3-Layer Extra-Low-E & Low-E 4

• Facade 3-Layer Extra-Low-E 5

Roof application
• Roof 2-Layer Low-E 6

• Roof 2-Layer Extra-Low-E 7

• Roof 3-Layer Low-E 8

• Roof 3-Layer Extra-Low-E & Low-E 9

• Roof 3-Layer Extra-Low-E 10

• Roof 2-Layer Solar Control Extra-Low-E 11

• Roof 3-Layer Solar Control Extra-Low-E 12

1) 6 mm tempered float + MS-F 60/14 – 16 mm argon  90% – 6 mm Planitherm XN
2) 6 mm tempered float + MS-F 60/14 – 16 mm argon  90% – 6 mm Planitherm One
3) 6 mm tempered float + MS-F 60/14 – 14 mm argon 90% – 6 mm Planitherm XN – 14 mm argon 90% –  6 mm Planitherm XN
4) 6 mm tempered float + MS-F 60/14 – 14 mm argon 90% – 6 mm Planitherm One – 14 mm argon 90% –  6 mm Planitherm XN
5) 6 mm tempered float + MS-F 60/14 – 14 mm argon 90% – 6 mm Planitherm One – 14 mm argon 90% –  6 mm Planitherm One
6) 8 mm tempered float + MS-F 60/14 – 16 mm argon  90% – 8 mm laminated Planitherm XN
7) 8 mm tempered float + MS-F 60/14 – 16 mm argon  90% – 8 mm laminated Planitherm One
8) 8 mm tempered float + MS-F 60/14 – 14 mm argon 90% – 8 mm Planitherm XN – 14 mm argon 90% – 8 mm laminated Planitherm XN
9) 8 mm tempered float + MS-F 60/14 – 14 mm argon 90% – 8 mm Planitherm One – 14 mm argon 90% – 8 mm laminated Planitherm XN

10) 8 mm tempered float + MS-F 60/14 – 14 mm argon 90% – 8 mm Planitherm One – 14 mm argon 90% – 8 mm laminated Planitherm One
11) 8 mm tempered float w/ Stopsol Supersilver + MS-F 60/14 – 16 mm argon 90% – 8 mm laminated Planitherm One
12) 8 mm tempered float w/ Stopsol Supersilver + MS-F 60/14 – 14 mm argon  90% – 8 mm Planitherm One – 14 mm argon 90% –  8 mm laminated Planitherm One

Please note that Microshade® for roof applications is rotated at certain tilts and orientations, however, this is done 
automatically in LightStanza when the product is selected. 

For special applications you can consult our Daylight Guideline on how to make your own custom BSDF using 
MicroShade®, to be used in LightStanza. If you have any questions, please contact us at support@microshade.com 

Simulation settings 
For all simulations with MicroShade® we recommend using the highest available simulation quality, due to the 
complexity of the MicroShade® structure. 
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Setting up a simulation in LightStanza with MicroShade®

Applying MicroShade® to the project
1.  LightStanza uses external 3D modelling tools as a basis for the simulations. Models from SketchUp, Rhino and Revit can 

be used and imported. Before importing the models into LightStanza, be careful to read the “Preparing your Model for 
Generating Results in LightStanza” section under the “Help” tab in the LightStanza app.

2. Windows are recognized in the following way in LightStanza, depending on the 3D modelling tool used:

a. SketchUp – Windows are recognized as glass material (less than 100% opacity)
b. Revit - Windows are recognized as glass material (less than 100% opacity)
c.  Rhino - While windows are recognized as glass materials in SketchUp and Revit, in Rhino you must assign an 

opaque blue material to your windows (or have them in a layer containing "Glass" "Glazing" or "Window" in the 
name)  for them to be recognized in LightStanza. When setting the layer color for your windows, change the 
color of the material to blue, which is RGB (0,0,255). Anything that is set to blue will be uploaded into 
LightStanza as a window or skylight, so make sure you remove any extra blue materials that you would not 
like to be uploaded as a window or skylight.

3.  LightStanza comes with a variety of predefined MicroShade® glazings. To apply a MicroShade® glazing to the project, 
navigate to the “Materials” tab in the left-hand menu. MicroShade® is listed as a “Complex Glazing (Manufacture)” and can 
be found in the “Product Library”.

4.  When the appropriate MicroShade® glazing has been selected, the MicroShade® material is added to the glazing
by clicking on the glazing surface with the paint bucket. If the window is grouped together with other windows, the
MicroShade® material will be added to the whole group by default. To change this, click on the paint bucket to remove the
“G” next to it. The MicroShade® material can now be added to individual glazing surfaces.

a.  To check if the MicroShade® material has been applied correctly, hover the mouse over the MicroShade®

layer in the materials tab. The surfaces with MicroShade® applied will now be highlighted in the model view.

Figure 1: MicroShade® product materials 
can be found under "Product library" in the 
"Materials" tab.

Figure 2: When the appropriate MicroShade® 
material has been chosen, it can be added 
from the "In Design" tab to the project.

https://lightstanza.com/general-workflow-help-guides/#prepareresult


5. If you have made your own custom window (BSDF) with  MicroShade® following the Daylight Guideline it can be
uploaded for use in LightStanza by going to "Uploaded BSDF Library". If you have never uploaded any, this tap will
be empty and new BSDF files can be uploaded by clicking "Upload new .xml file" .

6. After the BSDF has been uploaded, click on it. This will take you to the "Apply/Edit Materials in Design" tab. The BSDF
can now be found under "Complex Glazing (User uploaded)". From this tab you can apply the material to a surface, like you
would with one of the predefined glazings from the Product Library.

Figure 3: If you have made your own custom MicroShade® 
window (BSDF) it can be uploaded under "Uploaded 
BSDF Library".

Figure 4: After uploading the BSDF, click on it under 
the "Uploaded BSDF Library" tab and it will be 
added to the project.

Figure 5: When the BSDF is added to the project, it 
can be found under the "Apply/Edit Material in 
Design" tab. From this tab the material can be 
applied to surfaces, like you would with glazing 
from the Product Library.

https://microshade.com/media/45661/daylight-guideline.pdf


Daylight simulations with MicroShade® in LightStanza

3. Continiue through the remaining set-up parameters. Set the quality to high, click on "Show quality details" 
to access more advanced parameters regarding the precision and quality of the simulation. If you are 
only using MicroShade ®  as shading you can disregard the "Optimizations" tab.

Figure 7: Simulation set-up menu of type "Annual Grid 
Illuminance". Calculating sDA, DA and UDI.

1.  After MicroShade® has been successfully added to the windows, a daylight simulation can be performed from the 
“Activity” tab. Simply click on “Calculate” and set-up your simulation. UDI and sDA, among other metrics, can be 
computed under "Annual Grid Illuminace", just remember to check them off in the top drop-down menu "Metrics".

2. Go through the rest of the tabs and set up "Period and Occupancy", "Sky conditions"  and "Grid Settings".
The "Thresholds" tab relates to the metrics selected. We recormend to leave those at their default values, since   
they are set accordingly to the current standards. However, if custom thresholds are needed, this is where you can 
change it.

Figure 6: Simulations can be performed 
from the "Activity" menu.

LightStanza can performe both Point-In-Time, Annual grid based calculations and Daylight Renderings among others



4. When the simulation has been set-up, start the simulation by pressing “Start”. Because LightStanza is cloud-
-based, the browser window can be closed while the simulation is running and opened again when the
simulation has finished. Depending on your subscription, several simulations can be calculated at the same time.

5.   When the simulation is done, click on the activity in the “Activity” menu and view your result, either directly on the 
model with 3D view or get a 2D report. The options become available when hovering the mouse over the activity.

Figure 8: Example of a sDA calculation shown in a 2D report.

Please note if using a custom/user made MicroShade®

A rotation of MicroShade® is normally done to optimize the g-value. For vertical facades, MicroShade® are never rotated, 
while MicroShade® in roof windows can be rotated depending on the orientation and inclination of the roof. Rotation should 
be considered for orientations between northeast (45°) and northwest (315°) for all roof windows. Please contact MicroShade 
A/S at support@microshade.com in these cases, to get the right rotation angle.

For more information on which MicroShade® type to choose for your project, please see the selection guidelines on 
www.microshade.com, or contact us at support@microshade.com.
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